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Creative Cloud Libraries accelerate work by reducing clicks in the 
creative process. By making it easy for designers to use the right 
assets—and for enterprises to control the use of assets—Creative 
Cloud Libraries improve efficiency almost 8x. The following use-cases 
are most often cited by our enterprise customers:
C O R P O R AT E  S T Y L E  G U I D E

Store corporate colors, type styles, and brand assets in a read-only Library to maintain control, 
ensure brand consistency, and know that designers always have the most up-to-date assets.

S H A R E D  P R OJ E C T  L I B R A R I E S

Teams may easily share design elements, colors, text styles, stock photos, brushes, videos, and 
more when collaborating. These items, as well as updates, are automatically synchronized 
across all users.

U S E R  E X P E R I E N C E  E L E M E N T  L I B R A R I E S

Web, mobile, and UX design teams often reference buttons, menus, and other user interface 
elements across multiple design projects. These elements can be saved from Adobe XD and 
then utilized as Components across multiple XD projects.

Overview

Independent research study on 
Creative Cloud Libraries

Pfeiffer Consulting LLC, an independent research 
firm, found that CC Libraries can greatly improve 
productivity. 

D O W N L OA D  T H E  R E P O R T  H E R E :

Adobe Creative Cloud Libraries:  
Boosting productivity for creative teams

Corporate style guides are a good use case for Creative 
Cloud Libraries. A Library curator can create a read-
only Library and share it with design staff. Designers 
can use elements from the Library in their designs, 
but cannot edit the original brand assets. If the Library 
curator changes a brand asset, it is updated for all 
collaborators across all Creative Cloud applications 
and projects that reference the Library item.
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The benefits 
of Libraries for 
creative work

Creative Cloud Libraries make it 
easy to capture design assets from 
Adobe creative apps and Adobe Stock 
and then easily re-use those assets 
virtually anywhere.

Libraries help reduce clicks and 
minimize the time searching for 
design assets.

While Creative Cloud Libraries are 
simple to use, organizations should 
have a good understanding of 
how they work in order to derive 
maximum benefit.

Enterprise creative organizations may think about Libraries as a curated 
brand asset repository or a live, real-time style guide, ensuring that any 
materials utilized from that Library will be the most current versions of 
those files. Libraries have some unique qualities that help solve typical 
collaboration issues:

C R O S S  D O C U M E N T

Items stored in a Library aren’t document-specific—create a Library item 
in one document and use it in another.

C R O S S  A P P L I C AT I O N

Store frequently used elements in one app and use them in another.

C O L L A B O R AT I V E  C O N T R O L

Share frequently used elements with others. Read-only invitations offer 
enterprises control over their brand assets.

C L O U D  C O N V E N I E N C E ,  L O C A L  P E R F O R M A N C E

Elements are automatically synced to your desktop so they work fast even 
when you don’t have an internet connection.

H I G H  V O L U M E

You can have a virtually unlimited number of Libraries, each with a unique 
name. Each Library can store up to 10,000 elements. You are limited only 
by the amount of your Creative Cloud storage.

What’s the difference between Creative 
Cloud Libraries and a DAM (Digital Asset 
Management) system?

Creative Cloud Libraries are not a replacement for a 
DAM. A DAM system is primarily intended to maintain 
a large number of approved image assets. Creative 
Cloud Libraries are best suited for design elements 
that speed in-application tasks such as creating and 
applying colors, paragraph styles, page elements, and 
assets. Creative Cloud Libraries are synced to each 
user’s desktop. A DAM, by contrast, runs exclusively 
on a server or in the cloud.
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How do Creative 
Cloud Libraries work?

Library assets can be created in many 
ways: via drag and drop, by clicking the 
Add Asset button at the bottom of the 
Libraries panel, with the Adobe Capture 
mobile app, or by using the Creative 
Cloud desktop app. When a Library 
asset is updated, it synchronizes with 
Creative Cloud and each subscribed 
user receives the change.

You don’t need to be online to 
use Library assets since they are 
synchronized between your hard 
drive and the cloud. For example, 
if you travel, the next time your 
computer connects to the internet, 
the Library will update with the most 
recent changes.

1

3

2

4

Using the Libraries panel in almost any Adobe Creative 
Cloud app, Ashton creates a Library and adds assets and 
elements to it. The Library is saved locally on his computer 
and syncs to Creative Cloud.

Emily accepts the invitation to the Library.

Ashton invites Emily to the Library he created.

The Library and its contents are synced from Creative 
Cloud to Emily’s computer.

NOYES

Ashton has invited you to join
the Company Brand Library.
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What can go into 
a Library?

Creative Cloud Libraries make your 
favorite assets available to you 
anywhere. You can add images, colors, 
text styles, and other assets in most 
Creative Cloud desktop and mobile 
apps, and then easily access them 
across other apps for a seamless 
creative workflow. Here are the types of 
assets that each application can save to 
a Library or access from a Library.

Photoshop Illustrator InDesign Bridge Premiere Pro After Effects Rush Animate Dimension Dreamweaver XD Capture Stock Fresco

Paragraph styles • •
Character styles • • • •
Color swatches • • • • • • • • •

Color themes • • • • • • • • •
Text • •

Patterns • • •
Gradients • • •

InDesign page items • • • • • • • • •
Illustrator artwork • • • • • • • • • •

Photoshop layers/layer groups • • • • • • • •
Photoshop layer styles •

Graphics* • • • • • • • • • • •
Brushes • • • •

Lumetri color looks • • •
Animate animations/symbols • •

3D models and lights • •
3D materials • • •

XD components •
Video • • • •

Templates • • • • • • • •
* Any file in the ai, png, bmp, psd, svg , gif, jpg , tif, pdf, heic, heif, and dng formats. File type support is determined by the application.

“All the digital designers at Atlantic Records 
use Creative Cloud Libraries differently, but 
we all have one collaborative library. This 
is our asset locker, which contains all of our 
templates and common assets for quick, easy 
reference. The majority of the work we do 
has a really tight deadline, so having one 
centralized location is vital.” 

Dana Tandoi 
Senior Manager, Atlantic Records
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Create a corporate 
style guide Library

A

C

BDisplay the Libraries panel on your screen.

•	 In most Creative Cloud applications you’ll find the panel 
in Window > Libraries.

•	 In Animate, InDesign, and Dreamweaver you’ll find the 
panel in Window > CC Libraries.

•	 In Adobe XD, you’ll find the panel in File > Open 
CC Libraries.

Give the Library a name and click Create. Next, you can populate the 
Library with design components.

Select Create New Library in the Libraries panel menu.

Step 1: Create a Library

In the next few pages we’ll use a corporate style guide 
as an example to show you how to create and use a 
Library. The Library can be created right in your cre-
ative application of choice by using the Libraries panel. 

“Whenever we introduce a new feature, we 
create a new Creative Cloud Library with all 
of the icons and other design elements so 
we’re all in sync.”  

Marie West 
Senior UX Manager, Poshmark
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Create a corporate 
style guide Library

A

B

Select some artwork in Illustrator, then click the Add 
Content button  and select Graphic to add the 
artwork to the Library as a graphic.

You can also drag and drop ar twork from an 
Illustrator page into a Library, but clicking the 
Add Content button   provides more control 
over which properties of the artwork are added to 
the Library.

Right-click the asset name and choose Rename to 
change the name to something meaningful.

Step 2: Add design assets to a Library

Creative Cloud Libraries provide a mechanism to 
capture design elements from a variety of apps: 
Photoshop, Illustrator, InDesign, XD, and more. You’re 
not limited to desktop applications. You can capture 
inspiration, whenever it strikes, using mobile apps 
such as Adobe Capture, or download assets from 
Adobe Stock.

This examples uses Illustrator.
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A

C

BSelect an object that has a color fill or stroke in Illustrator, 
then click the Add Content button  and select Fill Color 
or Stroke Color to add the color to the Library.

Hover over the color, and you’ll see the CYMK or RGB value 
of the color displayed. The color is added to the Library 
as a CMYK color if it is added from a CMYK document, as 
an RGB color if it is added from an RGB document, or as 
a spot color if the added color is a spot color.

You can also right-click on a color swatch to add a Note. 
This can be helpful to provide context for when a certain 
color should be used.

The asset is automatically named with the Hex value of 
the color. Right-click the name and choose Rename if you 
wish to rename it to something else.

Step 3: Add color swatches

You can greatly simplify and standardize color com-
munication across your teams by adding swatch colors 
to a Library.

Brand guidelines often specify RGB, CMYK, HEX, and 
spot color versions of each color. You can either create 
multiple libraries, one for each color space, or create a 
single library and organize the colors by groups (see 
page 19).

This example uses Illustrator.

Create a corporate 
style guide Library
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A

C

BSelect some text in an InDesign document, then click 
the Add Content button  and select Character Style 
or Paragraph Style to add the text style to the Library..

If your document contains named Paragraph Styles or 
Character Styles in the Paragraph Styles or Character Styles 
panels, you can add these styles to a Library by selecting 
one or more styles in the panel and clicking the Add to 
Library button  at the bottom of the panel.

Right-click the asset name and choose Rename to change 
the name to something meaningful.

Step 4: Add text styles

Standardizing typographic styles is important for 
maintaining brand compliance. Using paragraph and 
character styles in your layouts reduces clicks and 
increases productivity.

Illustrator and InDesign support paragraph styles in 
Libraries, while Photoshop, Illustrator, InDesign, and 
XD all support character styles in Libraries.

This example uses InDesign.

Create a corporate 
style guide Library
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A

B

In an existing or new Photoshop document, drag a graphic 
from the Libraries panel onto the canvas.

Adjust the transform handles to scale the item, then click 
the Commit button or press Enter.

Click the icon for a color that you’ve stored in your Library.  
You’ll see that the color is applied as the current foreground 
color in Photoshop.

Step 5: Use Library assets

Once assets are saved in CC Libraries, you can reuse 
them in your designs—in the same file, another proj-
ect, or another app—without worrying that you’ll grab 
the wrong versions.

To add a graphic asset to your project, you can drag it 
directly from the Library onto your Illustrator artboard, 
Photoshop canvas, or InDesign layout, or into projects 
in other Creative Cloud applications.

To apply colors, text styles, layer styles, and certain 
other types of assets, select the object, text, or other 
item to which you want to apply the asset, and click 
the thumbnail of the asset in the Libraries panel.

This example uses Photoshop.

Create a corporate 
style guide Library
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A

C

BChoose Invite people from the Libraries panel menu.

The potential collaborator will receive an email invite. 
They must click through the email to accept the invitation 
(or respond to a notification they will receive through the 
Creative Cloud desktop app). Once they have done so, the 
Library you have shared, along with all of its assets, will 
appear in their Libraries panel. 

Your default browser is launched. Type one or more email 
addresses of your collaborators. After each address that you 
type, choose Can View or Can Edit, and then click Invite.

Step 6: Add editors and viewers 
for collaboration

You can invite other Creative Cloud users within or 
outside your organization to collaborate on individual 
Libraries you create. Each collaborator that you invite 
can be given either Can Edit or Can View permission.

When you provide Can Edit permission to a Library, 
collaborators can use, modify, rename, move, and 
delete Library content. Can View permission (aka 
read-only) allows recipients to view and use assets, 
but not modify the assets or the Library itself.

A Library with Can View access ensures your creative 
assets stored in Creative Cloud can’t be changed or 
deleted by other collaborators, while still making those 
assets available for use by your team.

Create a corporate 
style guide Library
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A

C  D

BIn an existing or new Photoshop document, right-click 
on a graphic asset in a Library and select Place Linked.

Right-click on another graphic asset in a Library and select 
Place Copy.

Note the Smart Object icon on the layer in the Layers 
panel. This indicates that the asset is embedded in the 
Photoshop document as a smart object. The asset is not 
linked to a Library, and will not update in the document 
if the Library asset is changed.

Note the cloud icon on the layer in the Layers panel. This 
indicates that the asset is linked to a Library. When the 
Library asset is changed by you or a collaborator, the asset 
will update in this document.

Step 7: Use and update linked assets

Photoshop, Illustrator, and InDesign all have the unique 
ability to use assets from a Library as either “linked” 
or “copied” (unlinked) assets. It’s important to under-
stand the difference.

Linked assets remain associated with the original asset 
in the Library. When the original asset is changed or 
updated, all instances of its use in Photoshop, Illustrator, 
or InDesign documents are automatically updated.

Copied, or unlinked assets, do not change in the 
Photoshop, Illustrator, or InDesign documents where 
they have been used when the original Library item 
is changed.

This example uses Photoshop.

Create a corporate 
style guide Library
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Update Library assets 
in a collaborative 
workflow

Working with linked graphic assets 
in a collaborative workflow can be 
very powerful. The workflow for 
working with linked graphic Library 
assets is similar in InDesign, Illustrator, 
Photoshop, XD, and Dimension.

1

3

2

4

Matt has “Can View” privileges to a shared Library. He 
places an Illustrator graphic from the Library into his 
InDesign layout as a linked asset.

Carol saves her changes in Illustrator and closes the file. 
The Library item is updated on her local drive and synced 
to Creative Cloud and to all her collaborators. 

Carol has “Can Edit” privileges to the same shared library. 
She decides to change the color of the Library asset that 
Matt used. She double clicks on the asset in the Library 
to edit it . The graphic opens in Illustrator, where she 
changes the color.

The revised Library item is automatically updated in 
Matt’s Libraries panel. Working in his InDesign layout, 
Matt receives an alert that the graphic is out of date in 
his layout, so he updates it in the InDesign Links panel.
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1 3

5

4

2

Benefits of the Creative 
Cloud desktop app

As valuable as it is to create, name, 
and update Library assets right inside 
creative applications, sometimes it 
is useful to be able to see, sort, and 
search assets across multiple Libraries. 
The Creative Cloud desktop app is 
a convenient place to manage and 
organize your assets in a workspace 
that provides more “elbow room” than 
the Libraries panel in applications.

1 	 Show a list of all your Libraries

2 	 Select a Library

3 	 Search Library assets and more

4 	 Manage assets

5 	 Display large thumbnails
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Create groups

There are two ways to organize and 
view assets in a Library. “By type” 
organizes the assets according to 
file type, displaying all the swatches 
together, all the graphics together, all 
the type styles together, and so on.

“By group” allows you to create 
groups (much like folders) to fit your 
organizational needs. For example, you 
could organize your logos into groups 
named Primary Logos and Alternate 
Logos, or your colors into CMYK, RGB, 
and Spot Color groups.

1

3

2Choose View by Group.

Drag assets into the group. By default, the assets are sorted 
in chronological order in the group, with the most recently 
added assets at the top.

You can drag and drop Library assets within the group or 
between groups to specify the order. When you change 
the order of assets in a group, the same order is visible 
across all applications and for all the collaborators with 
whom you’ve shared the Library.

Click Add Group, and then give the group a name. Each 
Library can have as many groups as you wish.
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Move elements

There are two easy ways to copy 
or move assets from one Library to 
another—right-click or drag and drop.

1

2

Select the assets you want to copy or 
move, right-click, and choose Copy 
Selected Items to or Move Selected 
Items to, and then select the destina-
tion Library.

Or, drag and drop assets from one Library to another. Add the Option 
key (macOS) or Alt key (Windows) to copy the items instead of 
moving them.
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Add elements

The Creative Cloud desktop app offers 
a fast way to “bulk load” assets into 
a Library. Just drag and drop one or 
more files from the macOS Finder or 
Windows File Explorer into a Library in 
the Creative Cloud desktop app.

This is a great way to populate a Library 
from an existing folder of assets in any 
of the following file formats: ai, png, 
bmp, psd, svg, gif, jpg, tif, pdf, heic, heif, 
dng, psdt, ait, indt, fla, mp4, mov, wmv, 
or mpeg.
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Adobe Stock

Adobe Stock delivers the creative assets 
that you need with the tools to find 
and use them quickly and efficiently. 
Adobe Stock is deeply integrated with 
Creative Cloud Libraries.

1 Search for Adobe Stock assets in the Libraries panel within 
most apps, or use the Adobe Stock website to add a water-
marked preview of any stock asset to any of your Libraries.

2 Then drag the watermarked stock asset from the Libraries panel to 
your creative project. When you’re satisfied that the stock asset is 
appropriate for your project, you can license the stock asset right 
in the Libraries panel.

Photoshop, Illustrator, InDesign, Premiere Pro, and After Effects take 
this integration even deeper. When you license the stock asset, 
all linked instances of the stock image in your open documents 
are automatically updated. In Photoshop, any non-destructive 
edits made to the asset are automatically preserved—potentially 
saving hours of rework.
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Adobe Capture 
mobile app

The purpose of Adobe Capture is to 
help you capture inspiration from the 
world around you and generate an 
asset you can add to your Libraries 
and then use in your creative projects. 
Starting with your device camera, or a 
photo from your camera roll, you can 
create seven different types of assets:

•	 Materials that can be applied to the surface of a 
3D model in Adobe Dimension.

•	 Automatically identify the type style in a photo and 
save it as a text style to use in Photoshop, Illustrator, 
InDesign, or XD.

•	 Convert images into vector SVG shapes to use in 
many other Creative Cloud applications.

•	 Extract five-color color themes or gradients.

•	 Capture color and light, then generate unique looks 
to enhance your video projects.

•	 Generate geometric bitmap and vector patterns to 
use in Photoshop and Illustrator.

•	 Create custom bitmap and vector brushes to use 
in Photoshop, Illustrator, and Fresco.

Here’s how to capture a color theme: 
choose Colors and then snap a photo.

Capture extracts the dominant colors 
from the image, and builds a color theme. 
Edit the colors in the theme as you wish..

Name the theme, choose a Library to save 
the theme to, and then tap Save.

In almost any Creative Cloud application, 
go to the Library you saved the theme to, 
and use it in your design.

1 2 3

4
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Adobe Capture 
in Photoshop

Much of the creative fun built into 
the Adobe Capture Mobile App (see 
page 24) is also available right in 
Photoshop. This allows you to quickly 
create four types of assets from one or 
more Photoshop image or layers:

•	 Generate geometric bitmap patterns to use 
in Photoshop.

•	 Convert images into vector SVG shapes to use in 
many other Creative Cloud applications.

•	 Extract five-color color themes.

•	 Create gradients with up to 15 colors extracted 
from your image.

1 2With a document open in Photoshop, 
choose a Library in the Libraries panel. 
Click the Add Content button  In the 
panel and select Create From Image.

Select Patterns, Shapes, Color Themes, or 
Gradients at the top. Choose the desired 
options at the right, and then click Save to 
CC Libraries.

C R E AT I V E  C L O U D  L I B R A R I E S  G U I D E    |    M ay  2 0 2 0   2 5



The Creative Cloud 
mobile app

The Creative Cloud mobile app lets 
you view and manage your libraries on 
the go.

1 	� Search for assets in your Libraries 
by name.

2 	� Change the way items in the 
Library are displayed and sorted. 
Invite others to join the Library.

3 	� Export, download, or share a link 
to the asset. Rename, duplicate, 
move, or delete the asset.

4 	� Add items to the Library from 
Adobe Stock, the camera, your 
camera roll, or other files on 
your device.

1 2

3

4
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Adobe Fresco and 
Photoshop on the iPad

Fresco is a drawing and painting app 
built specifically for touch-first and 
stylus-powered platforms like the 
Apple iPad with Pencil, Wacom Mobile 
Studio Pro, and select Microsoft Surface 
devices. You can access your Creative 
Cloud Libraries in both Fresco and 
Photoshop on the iPad.
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Adobe Premiere Rush

Adobe Stock features a large collection 
of motion graphics templates. These 
templates can be saved to a Library 
and then used in both the mobile and 
desktop versions of Adobe Premiere 
Rush (as well as Adobe Premier Pro).

1

2

3 4

Click the Titles icon.

Choose a Library.

Double-click on a motion graphics template that 
you’ve added to the Library from Adobe Stock.

The asset will be added to the project timeline. Edit the attributes 
of the template in the properties panel.
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Microsoft Word 
and PowerPoint 
integration

The Adobe Creative Cloud Add-in 
for Word and PowerPoint allows 
you to use assets from CC Libraries 
in Microsoft Word and Microsoft 
PowerPoint, as well as save assets to 
your Libraries from those applications. 
Graphics, colors, character styles, 
paragraph styles, and text assets are 
supported. System requirements 
and instructions for downloading, 
installing, and using the Add-in can be 
found here.
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https://helpx.adobe.com/creative-cloud/help/libraries-addin-microsoft-office.html


Zapier integration

Creative Cloud Libraries for Zapier lets 
you create automatic workflows (called 
“Zaps”) that connect your Creative 
Cloud Libraries with other third-party 
apps. For example, you could configure 
a Zap that sends a Microsoft Teams 
or Slack message whenever a new 
collaborator is added to a Library.

For instructions on how to connect 
your Creative Cloud Libraries account 
with Zapier, see adobe.ly/2UxJ2gl.
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Enterprise Creative Cloud Libraries



Export, import, and 
archive Libraries

Exporting a Library is useful when 
you want to transfer ownership of a 
Library from one Creative Cloud user 
to another, or archive the contents of a 
Library you no longer need.

The top three reasons to export Libraries:

Pass the baton: If your role changes, you can export 
your libraries and store the files for the new owner 
to import.

Clone it: Creating a CC library for one seasonal pro-
motion can save a lot of time when the next season 
rolls around.

Keep it safe: Store libraries off-line until they’re ready 
to reintegrate into current design projects.

1

2

To export a Library, select the Library in the Libraries panel, 
then choose Export “(Library name)” from the Libraries 
panel menu.

This will export all the Library items together into a single 
cclibs file. This special file contains all the Library assets, 
as well as asset names, groups, everything necessary to 
create an exact duplicate of the Library.

You could archive this file on a server or send it to another 
user so they can have their own copy of the Library.

To import a Library, choose Import Library from the 
Libraries panel menu, and then select a cclibs file.

This will extract all the assets from the cclibs file, and create 
a new Library with the same name as the original Library.
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Best practices for 
enterprise Libraries

R G B  V S  C M Y K  A S S E T S

Libraries do not offer a method to filter items by color space. There are 
three possible workarounds:

•	 Add text to the Library asset name such as Logo (RGB) or Logo (CMYK).

•	 Create separate RGB and CMYK groups within a single Library.

•	 Create separate RGB and CMYK Libraries.

R E S O L U T I O N  C O N S I D E R AT I O N S

Some disciplines such as UX design require specific resolution source files. 
Libraries do not offer a method to filter by size or resolution. Consider 
these workarounds:

•	 Add text to the Library asset name such as “1920 x 1080 Logo” or 
“1024 x 768 Logo.”

•	 Create a separate group within a single Library for each resolu-
tion needed.

•	 Create separate Libraries for each resolution needed.

N A M I N G  C O N V E N T I O N S

Be mindful about how you name Library elements. The only way to find 
Library elements is either visually or by searching for text in the item name. 
Be consistent with your naming scheme.

S P O T  C O L O R  S U P P O R T

Spot colors in Libraries are supported only in Illustrator and InDesign. 
They are not supported in other Creative Cloud desktop and mobile apps.

AV O I D  M U LT I - L E V E L  L I N K S

Libraries do not support multi-level links. For example, do not create a 
Library item that contains another Library item. Similarly, avoid creating 
a Library item with a link dependency to another file on your local file 
system or server. One workaround in InDesign and Illustrator is to embed 
the linked item before adding the asset to your library.

N O T  A L L  A P P S  T R E AT  P R O P E R T I E S  T H E  S A M E

If you use an InDesign text style asset in Illustrator, Photoshop, or XD, those 
applications will attempt to map the properties of the asset with the prop-
erties for text styles available in the host application. Any properties not 
found in the host application are ignored.

A LWAY S  A D D  AT  L E A S T  O N E  E D I T O R  T O  A  R E A D - O N LY  L I B R A R Y

It is likely that you will need to add or update Library elements over time. 
We recommend that you add at least one other person in your company 
as an “editor” (a collaborator with “Can Edit” privileges) to each of your 
Libraries. This way, if the Library owner is not available, the editor can 
make the changes necessary in the Library to keep everyone on deadline.

S H A R E  T H E  L I B R A R Y  B E F O R E  YO U  S H A R E  A 
D O C U M E N T  W H I C H  H A S  L I N K S  T O  I T

When multiple creatives across many teams need access to files utilizing 
Library assets, it is a best practice to share the Library first. If the source file 
is shared first, then applications will report missing links and each cloud 
asset will need to be relinked. Always share the Library first.

R E L I N K I N G  T O  A  D I F F E R E N T  L I B R A R Y  I S  T I M E - C O N S U M I N G

It is a lot of work to redirect links from one Library to a different one because 
each link must be updated individually.
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Frequently asked 
questions

H O W  M A N Y  L I B R A R I E S  C A N  I  H AV E ?

The number of libraries you can create is unlimited. You are limited only 
by your amount of Creative Cloud storage space.

H O W  M A N Y  E L E M E N T S  C A N  B E  S T O R E D  I N  A  S I N G L E  L I B R A R Y ?

While Libraries can contain up to 10,000 elements, we recommend the 
use of groups to more efficiently organize assets. Scrolling through very 
large Libraries can be tedious.

H O W  M A N Y  C O L L A B O R AT O R S  C A N  S H A R E  A  S I N G L E  L I B R A R Y ?

Each Library can be shared with up to 1,000 collaborators..

D O  L I B R A R I E S  C O U N T  AG A I N S T  M Y  C R E AT I V E  C L O U D  S T O R AG E  Q U O TA?

The content of each Library counts against the Library owner’s storage 
quota. But Libraries do not count against the storage quota for each user 
who accepts an invitation to a Library.

W H AT  I S  T H E  D I F F E R E N C E  B E T W E E N  I N V I T E  P E O P L E  A N D  G E T  L I N K ?

Invite people allows multiple users to work together securely and only 
with others who have been invited. Get link creates a public link that lets 
anyone with the link download a copy of your library assets. The copy is 
completely independent and not linked to the original Library.

W H AT  I S  T H E  M A X I M U M  F I L E  S I Z E  F O R  A  S I N G L E  L I B R A R Y  A S S E T ?

The maximum file size for any single asset is 1gb. Library assets must syn-
chronize to the cloud, and huge files take time to upload. Remember that 
other creatives may be using the same Library. The file size of elements 
like color swatches, text, and paragraph and character styles are negligi-
ble, while assets like multi-layer high resolution Photoshop content are 
heavy assets. 

I  A L R E A DY  U S E  A D O B E  B R I D G E .  H O W  I S  T H I S  D I F F E R E N T ?

Adobe Bridge is a desktop application that makes it easy to quickly locate 
and view large numbers of files in different graphic file formats stored on 
your local hard drive or file server.

Some people build “libraries” of assets consisting of folders on their hard 
drive, and use Bridge to quickly navigate those folders and work with the 
assets. This workflow is similar to that of Creative Cloud Libraries in some 
respects, but Creative Cloud Library assets are stored in the cloud, appear 
in a panel in the desktop applications, and are more closely integrated with 
the functionality of Creative Cloud desktop applications. Creative Cloud 
Libraries also work closely with the Creative Cloud mobile apps and spe-
cific third-party applications in ways that Bridge does not.

W H E R E  C A N  I  F I N D  M O R E  H E L P  W I T H  L I B R A R I E S 
I N  M Y  FAV O R I T E  A P P L I C AT I O N S?

Help with Libraries in Adobe Photoshop

Help with Libraries in Adobe InDesign

Help with Libraries in Adobe Illustrator

Help with Libraries in Adobe XD

Help with Libraries in Adobe Premiere Pro

Help with Libraries in Adobe After Effects

Help with Libraries in Adobe Animate

Help with Libraries in Adobe Stock

Help with Libraries in Adobe Dreamweaver

Help with Libraries in Adobe Fresco

Help with Libraries in Adobe Bridge
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https://helpx.adobe.com/photoshop/using/cc-libraries-in-photoshop.html
https://helpx.adobe.com/indesign/using/creative-cloud-libraries-sync-share-assets.html
https://helpx.adobe.com/illustrator/using/creative-cloud-libraries-sync-share-assets.html
https://helpx.adobe.com/xd/help/cc-libraries-xd.html
https://helpx.adobe.com/premiere-pro/using/creative-cloud-libraries.html
https://helpx.adobe.com/after-effects/using/creative-cloud-libraries.html
https://helpx.adobe.com/animate/using/creative-cloud-libraries-stock.html
https://helpx.adobe.com/stock/help/share-stock-assets.html
https://helpx.adobe.com/dreamweaver/using/creative-cloud-libraries-stock.html
https://helpx.adobe.com/fresco/using/fresco-creative-cloud-libraries.html
https://helpx.adobe.com/bridge/using/creative-cloud-libraries-in-bridge.html


Library ownership 
and continuity

Organizations may have multiple 
people and projects dependent on 
Libraries, so it is a good idea to put 
some thought into Library ownership, 
and focus on business continuity 
implications. The identity type of the 
Library owner can affect the longevity 
and security of assets.

W H AT  H A P P E N S  W H E N  A  L I B R A R Y  O W N E R  D E L E T E S  A  L I B R A R Y ?

When a Library is deleted by the asset curator, all the elements linked to 
the Library will remain in the various files, projects, and timelines. They 
will not disappear. Also, those assets will remember they were formerly 
associated with a Library. Assets will display error messages stating a relink 
is required. You can either embed the asset in the file or drag the asset 
into a new Library. 

E N T E R P R I S E  A N D  F E D E R AT E D  I D

Libraries belonging to Enterprise ID or Federated ID users only exist if the 
user is part of the organization and has a storage entitlement.

Therefore, any user who is subscribed to a Library owned by an 
Enterprise  ID/Federated ID will lose access to it if the storage entitlement 
is lost by the owner, which can happen when an account is deleted or the 
user is removed from an entitlement which includes storage.
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Conclusion

Creative Cloud Libraries are the perfect 
companion for capturing, organizing, and 
sharing your creative elements inside your 
favorite Creative Cloud applications. Whether 
you want to share creative elements with other 
designers, your creative teams, or even business 
stakeholders, Libraries increase the efficiency of 
your workflow and the workflows of everyone 
within your project group or organization, while 
helping ensure creative consistency across 
projects, platforms and teams.

http://www.adobe.com/privacy/policy.html
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